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Diamond Cut Audio Restoration
Tools Overview

Product Objective: We aim to provide a comprehensive set of tools which will
allow the user to remove extraneous noise and also enhance the sound contained
on old audio sources without degrading the content contained on the original.
Recognizing that there is a tradeoff between the degree of noise removed from a
source and the fidelity, transient and frequency response maintained, we have
sought to provide the highest level of user control while maintaining ease of use
over the variables which effect the Audio Restoration Process.

Diamond Cut Mill ennium, introduces a „Multi -filter“ and Diamond Cut LIVE
additionally introduces (feed-through) mode into its feature set.  Both products
include 4 new powerful Forensics filters.  The „Multi -filter“ allows you to
cascade at least 24 filters or effects.  The „Live“ (feed-through) mode allows
systems with full duplex capabilit y to bypass the system hard drive, and use the
computer as a „Live“ signal processor.  In other words, the signal is applied to
your computer’s audio input, is processed by the Diamond Cut algorithms, and
then is presented to its output a few hundred milli seconds later.  A tremendous
amount of versatilit y and flexibilit y has been added, particularly when „Live“ is
used in conjunction with the „Multi -filter.“ Additional new and innovative
features that have been incorporated into both versions of Diamond Cut include
the following:

1. 8 to 24 bit support at up to 96 kHz sampling rate
2. Sample rate conversions
3. Variable resolution added to the Continuous Noise Filter
4. Audio Spectrum Enhancer added to the Dynamic Noise
    Filter
5. Batch File Editor
6. Slot Filter for isolating sounds in Forensics applications.
7. Stereo Wavefile 180 degree phase-inversion
8. X-Y output display for plotting vector waveforms
9. Stereo Channel Blender / Crossover Filter & Effect
10. Speed Enhanced Display Functions (especially on large
      wavefiles)
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11. Improved Reverb
12. Printable 50/60 Hz Turntable Stroboscope discs
13. Additional factory presets
14. Additional Keyboard Accelerators
15.  Variable Resolution Spectrum Analyzer

Diamond Cut Productions, Inc. designed Diamond Cut Audio Restoration
Tools primarily to be used for the restoration of olde phonograph recordings.
These recordings often contain priceless performances which are marred by the
effects of age, wear, and the limitations of the media on which they were
originally recorded.  Diamond Cut is effective for "cleaning up" old cylinder
recordings, hill and dale Edison Diamond Discs (verticals), old 78's (laterals)
(both acoustically and electrically mastered), and of course, modern vinyl LP's
and 45 rpm records. However, the program can also be used for additional sound
restoration, special effects, or professional applications* such as:

1. Single Ended noise reduction of old analog tape recordings.
2. Cleaning up old optical and magnetic movie soundtracks.
3. Improving the intelligibility of surveillance recordings.
4. Improving the intelligibility of recorded telephone conversations.
5. Applying certain special effects or equalizations to any sound recording.
6. Removing static and noise from radio broaDiamond Cut asts, most

particularly from signals carried on the AM and Short Wave Bands.
7. Providing a graphical means for analyzing the noise content of audio

recordings.
8. Selective manual modification of recording waveforms.
9. Providing special audio effects for movie, radio, television or stage

theatrical use.
10. General purpose audio applications in Forensics laboratories.
11. Use as an instructional aid for the teaching of the applied principles of

Digital Signal Processing.
12. Cleaning up and enhancing video tape soundtracks.
13. Personal enjoyment and entertainment.
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This program has thus far been used on ten of Diamond Cut Productions
compact disc releases of historical musical material.  Its performance can be
auditioned on the following Diamond Cut Productions CDs. These CDs are
available directly from Digital Broadcast Systems:

• • Unreleased Edison Laterals 1
• The California Ramblers - - - Edison Laterals 2
• Hot Dance of the Roaring 20's - - - Edison Laterals 3
• Ernest Stonemand and his Dixie Mountaineers
• Eva Taylor with Clarence Williams - - - Edison Laterals 4
• • Vaughn De Leath, The Original Radio Girl, Edison Laterals 5
• • B.A. Rolfe and his Lucky Strike Orchestra, Edison Laterals 6
• • Hot & Rare - - - Hot Tunes from Rare Bands and Recordings
• • The Marvelous Melodies of Peter Mendoza
• • Edison Diamond Discs Fox Trots, 1920-1923
• • Rudy Vallee and His Connecticut Yankees: 1928-1930

See page 2 for details on the purchase of the above mentioned CDs.

Other labels such as the Smithsonian Collection of Recordings have used this
program to clean up several songs on their "American Songbook Series".  And
County Records used Diamond Cut to produce their release entitled "Ernest
Stoneman and his Dixie Mountaineers".  It was written by two engineers in
their spare time to facilit ate the very specific needs which arose in their
restoration of the Edison Lateral Collection of Test Pressing Recordings, which
is located at the Edison National Historic Site in West Orange, New Jersey.
Rick Carlson and Craig Maier developed this program over a four-year period.
They have now made it available to the general public with the idea in mind that
if it solved some audio restoration problems for themselves, it might also be of
use to others confronted with similar problems, particularly for those operating
with significant budgetary constraints.
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Here is a list of the functions that Diamond Cut can perform:

1. Record Audio signals onto your computer’s hard drive.
2. Playback Audio signals from your computer’s hard drive.
3. Display the Amplitude vs. time waveforms that represent your wave file.
4. Zoom-In and view details of a particular portion of your wave file.
5. Print the electrical waveform representation of your wave file.
6. Perform the following group of non-destructive editing on your wave file

including:
A. Remove Impulse Noise from a recording including  "ticks", "clicks",

and "pops."
B. Remove "Crackle" from a recording utilizing a Median Filter.
C. Remove Continuous Noise from an audio signal.
D. Display the frequency domain content of a selected portion of a wave

file.
E. Perform a Low Pass Filter function with 1st, 2nd or 3rd order slopes.
F. Perform a Bandpass Filter function with a Finite Impulse Response

(FIR) and an Infinite Impulse Response (IIR) algorithm.
G. Perform a High Pass Filter function with 1st, 2nd or 3rd order slopes.
H. Perform a Dynamic Filter function to reduce "Hiss" from an audio

signal.
I. Perform various file conversions such as left plus right, left minus right,

etc.
J. Perform an Average filter function.
K. Attenuate Hum or Acoustical Feedback from a recording.
L. Manually interpolate noise events out of your wavefile.
M. Frequency Equalize your recordings to create a more pleasing tonal

balance with the built-in 10-band Graphic Equalizer.
N. Correct the pitch of a recording with the „Change Speed“ Filter, with

linear or non-linear time contours.
O. Perform fractional speed remastering from a 45 RPM turntable, and

then convert it to normal speed with the „Change Speed“ Filter.
P. Create a wavefile „Songlist“ with Markers capable of CD data

Quantization for glitchless indexing.
Q. Attenuate Buzz from a recording using the Harmonic Reject Filter.
R. Add „tube-warmth“ or harmonic enhancer effects
S. Modify the dynamic range of recording
T. Set up a „noise-gate“ function
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U. De-ess an overly sibilant recording
V. Create or reverse an RIAA equalization curve with the 10 band

Paragraphic equalizer.  Also, create various 78-RPM turnover
equalization curves.

7. Perform the following group of destructive editing on your wavefile
including:
A. Fade in sequence with either a linear or a logarithmic envelope vs. time.
B. Fade out sequence with either a linear or a logarithmic envelope vs.

time.
C. Crossfade between two Wavefile sources with linear or logarithmic

timing.
D. Mute a portion of your wavefile.  This is useful for ridding a file of

stubborn "pops" or "thuds."
E. "Gain Ride" to even out variations in the sound level of a recording in

non-real time.
Edit Wave files using any of the following commands:
1) Copy
2) Paste Over
3) Paste Insert
4) Cut
5) Interpolate

F. Undo any of the destructive editing which you have performed with any
number of levels of the undo function that you choose to define.

8. Analyze Audio signals for Amplitude and Frequency content utili zing any
of three possible methods, including the use of a "built -in" spectrum
analyzer.

9. Measure the performance of the electronic components in your audio
restoration laboratory with a built -in Audio Signal Generator that is capable
of producing Sine and Square Wave signals (tones) of adjustable frequency
and amplitude.  It is also capable of producing white and pink noise using
the Random function.  Also included is a burst and linear sweep generator
function.

10. Real time "Preview" of all filter functions for instant evaluation of
parametric settings.

11. Hear the noise being removed by two of the filters through a „Keep
Residue“ mode.
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12. Add reverb to „dead“ recordings.
13. Create a Stereo Effect on monophonic recordings.

It is important to emphasize that Diamond Cut Mill ennium/LIVEperforms most
of its editing in a non-destructive manner. The source file remains non-modified;
only the destination file receives the modifications. Not all wavefile-editing
programs work in this manner, and some actually modify the source file directly
on your hard drive.

It will t ake some experience to achieve excellent results from the software so
don't be afraid to experiment. The preview feature will allow you to quickly
hear the results of parameter setting changes before you commit your computer
resources to the job of a complete file processing. Some PCs are not fast enough
to run all of the algorithms in real time, so you may find yourself making use of
the preview function often.  The minimum system configuration that we
recommend that you use to run Diamond Cut 32 is a 100 MHz Pentium.  A 166
MHz Pentium or higher will generally run most Diamond Cut algorithms in real
time or faster in non-preview mode, and for „Run“ mode performance, faster is
always better.  If you are using „Live“ you will want the fastest computer that
you can afford for maximum functionality, performance and versatility.
Most sound restoration jobs will t ake several passes with different algorithms
applied to achieve the best results.  Since many of these algorithms are non-
linear systems, the order in which some of the various filters are applied will
matter.  You will find more on this topic in the Impulse Fil ter section of the
Help file.

Note 1: Diamond Cut Mill ennium/LIVE utili zes the Wave file format for its file
system (*.wav).  Other sound file formats are not supported at this time.
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Getting Started with Diamond Cut
Millennium/LIVE

Installation
Congratulations, you’ve just purchased another affordable yet powerful
Tracer branded product.  You have our promise that you’ ll be satisfied
with your results without having to take a second mortgage to get them!

NOTE: Be sure to return the registration card to ensure support, upgrade and
bug fix notification.

To Install the software please follow these steps:

Windows 95/98/ME and Windows NT/2000 Instructions

1. Put the install CD into your drive.  If Autorun is enabled, installation
will begin immediately.

2. Press the Start button, choose Run from the pop-up menu
3. Type in the letter of your CD Rom drive
4. Press the OK button
5. The Diamond Cut install program will start. Follow the instructions on

the screen.

The software will be installed in a folder called Diamond Cut Productions. A
sample wavefile is supplied called demo1.wav.
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Configuration
Diamond Cut Mill ennium/LIVE does not require any special installation, but it
does require that your sound card be installed and working properly. If you have
more than one sound card in your system, make sure the one you wish to use has
been selected in the Device I/O screen (use the Edit->Device I/O menu).  Check
the Temp File Path under the Edit->Preferences menu. Diamond Cut
Mill ennium/LIVE automatically assigns temporary file names for files that are
being processed. You should set the temporary drive path for the disk drive that
you wish to use for audio editing. This is usually the drive with the most free
disk space. Keep in mind that high quality (44.1kHz) stereo recording consumes
10.5MB of disk space per minute.

Basic operating mode of Diamond Cut
Millennium/LIVE
Diamond Cut Mill ennium/LIVE always operates in a non-destructive manner.
When a file is processed with a Diamond Cut Mill ennium/LIVE filter or effect,
the software reads the source file, modifies it with the selected filter or effect,
then writes it to the destination file. The main workspace of Diamond Cut
Mill ennium/LIVE always has a source and a destination file. This mode of
operation has a few important benefits:

1. The original source file is not modified, leaving it available for instant
comparisons with the processed version.

2. The original material can always be recovered if the results of
processing are unsatisfactory.

3. Selected sections of the file can be reprocessed using different filter
parameters or different filters entirely (see sync mode).

Because of the non-destructive nature of the filters in Diamond Cut
Mill ennium/LIVE, there is no undo function for the filters. Instead, the original
source can be copied back to the destination file if a mistake is made. This
method greatly speeds up the program because it does not have to make a copy
of the data each time a filter is run.
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The following diagram illustrates the filtering process:

Sync Mode
Sync mode is the default mode of operation for Diamond Cut
Mill ennium/LIVE. In Sync mode, both the source and destination files track
each other. If you zoom into a section of the source file, the destination file will
zoom to the same section. When you process the source file using a Diamond
Cut Mill ennium/LIVE filter, the program reads the source file, processes it, and
writes it to the destination file at exactly the same position as the source file.
This means that if you want to reprocess a section in the middle of a song, just
highlight the section in the source file that needs processing and run the filter
again.

The filtered section will be written to the correct location in the destination file.
This mode of operation is useful for changing the filter parameters for only a
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section of a song, or for removing noise from a small section of the song without
having to process the entire file.

Note: Sync mode assumes that a destination file exists, and that it is the same
size as the original file. This is usually accomplished through the application of
one of the Diamond Cut filters to the entire file. For example, the file conversion
filter can be used to make the destination file into an exact copy of the source
file.

Sync Mode Operation

Non-Sync mode of operation
In non-sync mode, the highlighted section of the source file is read and
processed by the Diamond Cut Mill ennium/LIVE filter. The processed section
is then written to the destination file, starting at the beginning of the file. If a
destination file already exists, it will be overwritten (a prompt warns you of
this). This mode is useful when only a section of the source file needs to be
extracted, or for testing a filter’s settings before processing an entire file.

Non-sync mode operation
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Single file operations
Because of the nature of several operations, the Cut, Copy, Paste, and Fade
menu items operate on the file that is currently selected. This means that a Cut
will delete a section of the source file if it is the currently selected file in the
workspace. Likewise, a Fade operation will modify the highlighted section of
the selected file (Source or Destination).

All single file operations can be undone by using the Undo menu item. The
default number of undo levels is 10. The number of undo levels is selectable in
the Preferences dialog box. The maximum number of undo levels is limited to
100. When you close Diamond Cut Mill ennium/LIVE (Exit the program) all
undo information will be lost.

Preview Mode
All the filters in Diamond Cut Mill ennium/LIVE have a preview mode.
Preview mode lets you hear the result of a filter before writing the changes to the
Destination file. In Preview mode, you will hear the results of the filtered file as
it is being processed. If your computer is fast enough to keep up with the
calculations, the entire file can be previewed in this manner. All of the filters
have live controls, which means that adjustments made to a filter’s slide control
will be immediately heard in the preview output. If your computer cannot keep
up with the calculations, you will hear stuttering in the preview output. This is
because the playback is being paused while the computer calculates the next
section of music. This stuttering can be minimized by increasing the number of
“Preview Buffers“ in the Preferences Dialog box (Edit->Preferences).

Restoring a Recording
While there are many ways to use Diamond Cut Mill ennium/LIVE, the general
steps are outlined below. Keep in mind that any of the filters may be skipped if
the particular recording does not suffer from the kind of noise the filter is
designed for. You should always use the least amount of processing that will get
the job done. See the section on Filters for a brief description of each filter’s
function.  The tutorial on restoring the Demo wave file later in this booklet
describes some of these steps in detail.
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1. Record the source material
The source material is recorded from an external source into a Wavefile
using the Record function of Diamond Cut Pure Audio.

2. De-Click
The Impulse noise filter is used to remove ticks, pops, and other transient
noises from the recording.

3. DeHiss
You can use either the Continuous Noise filter or the Dynamic noise filter to
remove constant background hiss or other wideband noise from a recording.
This type of noise is the most diff icult to remove without effecting the
music.

4. Filter (HP, LP, Notch, Harmonic Reject, Equalizer)
The High Pass, Low Pass, Notch, Harmonic Reject, and Equalizer are all
filters that modify the frequency response of the recording.

Some examples are:

• High Pass filter for removing rumble
• Notch or Harmonic Reject filter for removing hums, buzzes or

feedback.
• Equalizer for adding bass or emphasizing the vocal range.

This step may be performed before the continuous noise filter to remove
rumble or high frequency noise. See the help file for additional examples of
which filter to use for a particular problem.

5. Trim, Fade-in/Fade-out
After the processing is done and you are satisfied with the results, you can
use the Cut, Fade-in and Fade-out functions to remove any noise that occurs
before and after the recording, such as the sound of the record needle being
dropped on the lead-in groove. Keep in mind that the Cut and Fade
functions operate on the selected file. This means that, unlike the filters, you
can modify the source file if you want to.
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6. Transfer to final format (CD, Cassette, DAT)
After the restoration process has been completed the file should be
transferred to a portable format such as CD, cassette or DAT. To transfer to
cassette or DAT, simply set up the cassette or DAT machine to record from
the computers sound card and play the wavefile. If you are restoring an
entire album or want to create a master tape, use the Playlist feature.

This allows you to create a list of wave files and play them back in
sequence, thus eliminating the time consuming steps of starting and
stopping the recorder between each song.

CD recorders usually have special software that must be used to record the
file onto the CD. Diamond Cut Mill ennium/LIVE has a CD quantization
feature that lets you perform special processing to ensure glitch free CD
masters.

Filters and Effects
The filters are at the heart of the operation of Diamond Cut Mill ennium/LIVE.
They are used to reshape the sound from its original form into a more pleasing
and noise-free result.  The following section lists all of the filters available in
Diamond Cut Mill ennium/LIVE along with a description of the type of f iltering
they perform.

• • Impulse Noise Filter

This filter is used to remove pops, ticks, clicks, and crackle from audio
recordings.  It is also useful for the elimination of “ static“ interference from
AM or Short Wave radio broaDiamond Cut asts. An Impulse looks like a
spike or fast change in the audio signal that is not related to the music. The
filter monitors the audio signal for ticks or pops and replaces them with an
approximation of the signal which would have occurred during the tick or
pop.
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• • Continuous Noise Filter

This filter is useful for reducing background “Hiss“ and other constant
noise from a recording or from a noisy FM radio transmission. It is referred
to as a “Continuous“ noise filter because unlike Impulse noise, Hiss is
present at all ti mes.  When adjusted properly, this filter can almost
completely eliminate all residual noise from a recording.  However, it is
easy to overuse this filter and leave the recording sounding dead and
lifeless, and also introduce digital artifacts into the music.

To use this filter, you must first take a sample of a section of noise. This
noise template will t hen be used to decide what is noise and what is music
during the filtering process. It is important to sample a section of the
wavefile that does not contain any music so that the filter does not remove
signals that contain musical information.

The filter graphically shows a frequency spectrum of the sampled noise.
This spectrum represents the amount of noise at each frequency band in the
recording. You can use the mouse to move the blue threshold line to tailor
the kind of noise reduction that the filter performs.

This filter should only be used on recordings that have littl e or no impulse
noise, or on recordings which have already been processed through the
Impulse Noise filter.

• Harmonic Reject Filter
The Harmonic Reject filter is used to remove harmonically rich noise from
a recording. Noises such as hums and buzzes from electrical mains, or
buzzes from broaDiamond Cut ast signals are the most common types. A
loose or bad ground connection on a turntable is a common cause of hum
that can be removed with this filter.

The filter removes the fundamental frequency along with a selectable
number of harmonics. Harmonics are multiples of the fundamental
frequency that are present in all signals that are not a sine wave. For the US,
a hum caused by a faulty ground will have a fundamental frequency of 50Hz
in Europe.
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• • Dynamic Noise Filter

This filter is another form of the “Continuous noise“ filter, but it operates
on a different principle than the previous filter. It is also useful for removing
“Hiss“ from recordings, but unlike the “Continuous Noise Filter,“ will not
introduce any digital artifacts into the recording. It is much more forgiving
of incorrect settings at the expense of less overall hiss reduction.
The Dynamic Noise filter can also be placed in another mode of operation
producing a spectral enhancer.  Signals above the threshold value will be
incrementally amplified in this mode.

The Dynamic Noise filter’s operation is based on a moveable Low Pass
filter. This low pass filter will attenuate the high frequency Hiss only when
there are no high frequency signals present in the music. This filter should
also only be used on recordings that have no impulse noise.

• • Low Pass Filter

This filter is called a Low Pass filter because it only passes through signals
that are lower than its set corner frequency. It attenuates high frequency
signals above the corner frequency.

The effect can be similar to turning down the treble control on a home
stereo except that the Low Pass filter is much more flexible. This filter can
be somewhat useful for reducing hiss in a recording, but care must be taken
not to reduce the „presence“ of a recording by eliminating too much of the
high end musical content at the same time.

It is most useful where a recording does not contain any musical
information above a certain frequency, and you wish to eliminate the high
frequency noise that would otherwise be present.

• • Bandpass Filter

Bandpass filters are essentially a combination of a low pass filter and a
high pass filter. It attenuates both the high frequency and the low frequency
portions of the audio spectrum. It is useful where the recording contains
extraneous noise in the low frequency region such as rumble or thumps,
and high frequency noise such as hiss.
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This filter can also be very useful for improving the intelli gibilit y of audio
recordings, especially speech, by eliminating the unnecessary portion of the
audio spectrum that is not used by speech frequencies to carry useful
information to the listener.

• • High Pass Filter

A high pass filter only passes signals that are above or “higher“ than the
corner frequency. It reduces the level of low frequency signals that are
below the corner frequency.  The effect can be similar to turning down the
bass control on a home stereo. This filter is very useful for reducing
turntable rumble, muddiness, and any other extraneous low frequency noise
in a recording.

• • Notch Filter

A notch filter attenuates signals that are near its center frequency setting.
The degree to which it attenuates frequencies near the center frequency is
determined by the bandwidth setting.  This filter is useful for removing 50
or 60 Hz hums from a recording. It is also useful for decreasing any sound
system acoustic feedback that may be found on some live recordings.  A
„Slot“ filter is also provided within the Notch filter menu item for Forensics
applications.  Multiple slots can be constructed using the Diamond Cut
Millennium/LIVE Multi-filter.

• • Equalizer

The equalizer is a famili ar filter that acts like an expanded tone control. The
audio spectrum is broken into 10 bands, each being one octave wide. Each
band’s gain (volume) can be independently adjusted to achieve the desired
audio result. This filter is useful for tonal shaping of the finished audio
product or to enhance the bass or treble of a recording. It is also useful for
improving the intelli gibilit y of recordings or “Bringing Out“ a particular
instrument or vocal.
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• • File Conversions

The file conversion filter is not really a filter at all but a way to convert
mono files to stereo and visa-versa. It can also be used to adjust the channel
balance or reverse the channels of a stereo recording, or convert a mono
source into a stereo file. It is useful in converting stereo recordings made
out of phase (such as old vertically recorded acoustic discs) into a stereo or
mono file that is compatible with modern systems.  File conversions also
includes two controls.  One set allows you to adjust the gain levels for each
channel.  The second control, called Time-Offset, provides a means for
azimuth correction, Forensics audio enhancement, and stereo simulation.  A
final important use of the file conversion filter is to simply copy parts of the
source file over the destination file. This is one way to revert back to the
original source file (undo) following a bad filter application.

• • Change Speed

The change speed filter is used for either fractional speed mastering or for
correcting the pitch of an off -speed recording. If your record skips when
played at normal speed, consider playing it at a slower speed and use the
change speed filter to restore the original pitch. If your recording is off -
pitch, or contains momentary pitch deviations, use the graphical pitch vs.
time contour graph to correct these deviations.

• • Reverb
The Reverb effect is used to add a realistic room sound to a recording. The
reverb is capable of simulating different size rooms, with different kinds of
reflective surfaces and decay times. The reverb filter lets you control the
overall room size, decay time, early reflection level, and mix between the
original material and reverb sound. Unlike most of the other filters in
Diamond Cut Mill ennium/LIVE, the Reverb filter is really an effect, rather
than a restoration tool.
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Demo File Tutorial
Restoring the Diamond Cut Millennium/LIVE
Demo Wavefile
The following is a description of a “basic“ procedure that will restore the
Diamond Cut Mill ennium/LIVE Demo Audio Wavefile, including settings that
will give reasonable (not optimal) results.  Its intention is to step you through an
audio restoration process in order to famili arize you with some of Diamond Cut
Pure Audio ’s features.  The song segment you will be restoring is titled “My
Sin“ (matrix # N-869G) which was performed by the Cali fornia Ramblers for
the Edison Company on 4-25-29.  It can be heard in its complete and restored
form on a Diamond Cut Productions release entitled “The Cali fornia Ramblers -
- - Edison laterals 2“ (DIAMOND CUT P-301D).

It is important to note that the steps are order dependent.

1. Open the Wavefile:
1.1  Open the Diamond Cut Mill ennium/LIVE demo wave file by using the

File, Open Source menu, and select the file called demo1.wav.
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2. Remove the Ticks and Pops:
The Impulse Noise Filter will be used to remove the ticks, clicks and pops
from the Demo Wavefile.

2.1  Click on the Impulse Noise Filter that can be found under the Filter
Menu.

2.2 Set the Impulse Filter Parameters to the following values:
     A. Threshold = 9900
     B. Size = 6
     C. Tracking = 1
     D. Vinyl LP mode is not checked  (in other words, this feature is not

enabled)
     E. Preview Mode is not checked

2.3 Click on “Run Filter“ using the left mouse button.  The computer will
start processing the file, and depending on the speed of your computer,
will have completed the file after somewhere between 5 to 60 seconds.
At the end of this process, you should note that the statistics dialog box
will have indicated that roughly 350 clicks have been removed from the
Source File.  This step will have completed the De-Clicking process.
The results of this process will be the file found in the Destination
Workspace.
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2.4 To hear the results of this process, press the play button on the toolbar
(the arrow pointing toward the left). Note: this step is optional.

2.5 Shut down the Impulse Filter by clicking the Close button on the dialog
box, using the left mouse button.

3.  Remove Low Frequency Rumble:
The next procedure is intended to remove low frequency “ rumble“ from the

Demo Wavefile.  You will be using the Diamond Cut
Millennium/LIVE High Pass filter.

3.1 Click on the “Make Destination the Source“ function which will be
found under the “File Menu.“

3.2 Next, click “OK“ in the “Save As“ dialog box. Diamond Cut
Mill ennium/LIVE will automatically assign a Temporary File name to
this new Source file.  It can be viewed in the newly opened “Source
Workspace.“

3.3  Click on the High Pass filter that will be found under the Filter Menu.

3.4 Set the following Parameters:
    Frequency = 55 Hz
    Slope = 18 dB / Octave

3.5 Click on “Run Filter.“ After the filter has completed its operation, the
results will be found in the Destination Workspace.
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3.6 To hear the results of this process, once again, click on the play button.
You should hear that the rumble on the original recording is now gone.
Your speakers must have good low frequency response to hear the
difference.

4. Remove the Hiss and surface noise:
This procedure uses the continuous noise filter. The term “Continuous
Noise“ refers to the constant background hiss and crackle that appears on
most old recordings.

4.1 Once again, click on the “Make Destination the Source“ feature found
under the File Menu.

4.2 Click on “OK“ in the “Save As“ dialog box.  The file, which had just
been in the Destination Workspace, will now be found in the newly
opened “Source Workspace.“

4.3 The purpose of the next process is to remove continuous noise from the
recording.  This includes such noises as hiss and other random noises.
You will be using the “Continuous Noise Filter.“

4.4 First, you must give the filter a sample of noise to use as a template. To
do this, highlight the first ½ second of the Demo Wavefile. To do this,
use the left mouse button and drag it until approximately the first 0.5
seconds of the source wavefile is selected. The highlighted sector will
be indicated in yellow.  Use the play button to be sure that you have
highlighted only lead-in groove noise, and no impulses from stylus drop
or music.

4.5 Click on the Continuous Noise Filter, which will be found under the
Filter Menu.

4.6 Click on the “Sample Noise“ button found in the filter dialog box. You
will see a blue threshold line appear above the red signal spectrum line.
It is only necessary to understand what is going on here if you are an
advanced user.  Otherwise just follow the directions.  If you are an
advanced user, you will find more information on the use of this filter
in other sections of the Help file discussing the Continuous Noise
Filter.

4.7 Set the following parameters for the Continuous Noise Filter:
     A. Attack Time = 40 msec.
     B. Release Time = 80 msec.

C.  Attenuation = 100dB



Extract: Diamond Cut Millennium/LIVE User´s Manual

28

More informations can be found in the 300 pages manual which is included with the Diamond Cut Software.

4.8 Highlight the entire source workspace by double clicking with the left
mouse button anywhere within the source waveform display area. It
may be necessary to move the Continuous Noise filter dialog box out of
the way before selecting the source waveform.

4.9 Click on the “Run Filter“ button. The results of the Continuous Noise
Filter processing step will be found in the Destination Workspace, after
your computer has completed running the algorithm.  To hear the
results, click on the play button on the toolbar.

This concludes our example of a “basic“ sound restoration job.  The next
advancement would be to adjust the filter parameters more to your own personal
taste. Furthermore, you may choose to run the graphic equalizer, low pass filter,
or some other filter after the continuous noise filter has been completed.  The
variations in the results that you can obtain are tremendous when you consider
all of the various permutations of f ilters and parameters available for you to
choose from.  Proficiency in the use of Diamond Cut Mill ennium/LIVE will
develop over time as you experience the various results that can be obtained
from the program.
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Also you may want to consider to upgrade this program to either Diamond Cut
Mill ennium or Diamond Cut LIVE if you need more sophisticated filters or
effects. Furthermore the provided manual with these version explains on more
than 300 pages in greater detail the audio restoration process. It also contains a
in depth tutorials on every filter and effect, a 70 pages appendix with
explanations on almost every aspect of restoring audio. Informations on
upgrading to Diamond Cut Mill ennium or Diamond Cut LIVE can be found on
page 37 of this manual.

By using the „Save Settings“ feature you can save the ranges of parametric
values that have worked well for you for certain filters as a function of the type
of materials you have restored.



Extract: Diamond Cut Millennium/LIVE User´s Manual

30

More informations can be found in the 300 pages manual which is included with the Diamond Cut Software.

Common Questions (FAQ)
This section lists some common questions new users have about Diamond Cut
Millennium/LIVE .

Q Why does the waveform display only show part of my file?

A By default, Diamond Cut Mill ennium/LIVE only reads the first few

megabytes of a wavefile for the initial display. This adversely affects none of the
wavefile processing operations. Portions not shown on the display can still be
played, filtered and operated on just as if they were displayed. To set the size of
the waveform that will be displayed, use the Preferences dialog box (under the
edit menu) and increase the “Display Length Limit“ to the size of the file you
wish to be displayed. Keep in mind that the larger the display size, the longer it
will take to initially open a wavefile.

Q How do I control the recording level of the audio signal?

A In Windows 95/98/ME, there is a speaker Icon in the lower right hand

corner of the Taskbar. Double-click on this Icon to bring up the control panel for
your sound card. There are level controls for the Mic or Line inputs of the sound
card. Also be sure that the correct input is selected (Mic, Line, or Aux) for your
particular recording setup. For Windows 3.11 systems you should either use the
mixer application that is supplied with your sound card or use the Windows
control panel to access the sound card driver utilities.

Q Why does preview mode sound like it is stuttering?

A  All of the filters in Diamond Cut Mill ennium/LIVE require a fair amount

of processing power. If your computer cannot complete the processing fast
enough to keep up with the audio stream, then the preview mode will stop and
start in short bursts that sound like stuttering. This effect can be reduced or
eliminated by increasing the number of “Preview Buffers“ in the Preferences
dialog box. Each „Preview Buffer“ adds about 10ms of pre-processing before
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preview playback starts. So increasing the Preview buffers to 50 will give
approximately 5 seconds of clean (non-stuttering) audio.

Q Will i ncreasing the amount of RAM in my computer make Diamond Cut

Millennium/LIVE run faster?

A  Diamond Cut Mill ennium/LIVE does not require huge amounts of RAM.

If your computer system has 12 to 16 Mbytes of RAM, then further increases
will not appreciably speed up the program. The software uses disk based
processing so hard drive speed and raw processor speed will generally have a
greater effect than increased RAM beyond a certain minimum.

Q Will a Pentium Processor with MMX speed up the program?

A No. While a faster clock speed is better regardless of the processor, the

MMX feature of all new Pentiums is designed to speed up Fixed-point
operations. Diamond Cut Mill ennium/LIVE performs all of its processing using
floating point calculations that are not affected by MMX.

Q I want to purchase a system optimized for use with the software.  What

sort of system will provide me with the fastest performance of all of the various
Diamond Cut Millennium/LIVE filters, effects, and editing features?

A  Purchase a computer with the fastest clock speed possible.  Check

benchmark performance of the CPU chips math co-processor performance, and
specify the one that produces the best results.  Keep Diamond Cut
Mill ennium/LIVE on a different hard drive from your wavefiles.  And use SCSI
hard drives as opposed IDE drives. Look for drives with fast access times.
Purchase a high performance sound card.  Lastly, turn off all superfluous
programs that may be running in background.

Q I am unable to record a wavefile using the Diamond Cut

Millennium/LIVE program.  What can I do?
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A If you press the record button and the recording level meters do not move,

check the following items:
1. Make sure that your music source (CD, tape player, DAT, etc) is connected

to the correct input on your sound card.  This should most likely be the
LINE or AUX input.

2. Go to the control panel, and click on the Multimedia Icon.  Make sure that
the correct audio card is selected as the recording device and that the
recording level is not set to zero.

3. Most sound cards place a volume control on the task bar.  Click on the
volume control icon to bring up the level control screen.  Select the
recording controls (usually a menu item.)  Make sure that the input is
enabled.  Sometimes the LINE or AUX inputs are disabled by default.

Q How do I avoid producing dropouts during recording or playback?

A Make sure that you have reviewed all of the following:

1. Make sure that you are using the latest drivers for your sound card.  They
can usually be obtained from the card manufacturers or Microsoft’s web
site.

2. Make sure that the screen saver and all power management functions will
not kick-in during recording or playback.  By default, the screen saver has a
1-minute timeout, so after 1 minute of no keyboard or mouse activity, the
screen saver will kick-in.  This flurry of disc activity will put a glitch on the
recording or playback of wavefiles.

3. Turn off all power saving features, or set their timers to a value of time
greater than the longest musical selection that you want to record or play.

4. Make sure that there is nothing in the Start-Up group.  Look in the
Windows Star t->Programs->Star tup group and remove any programs that
may run during your recording session.  A notorious culprit is Microsoft’s
Fast-Find feature.  It periodically searches the hard disk.  It is installed with
all Microsoft Office products.

5. If you are getting desperate, try disabling virtual memory in the Windows
control panel. Novice users should not attempt this because it can seriously
effect your PC’s performance.
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Q I have a vinyl LP that is very noisy, and still has too many clicks after

processing.  What can I do?

A Try running the impulse filter twice or more.  First run it with the Tracking

control set to zero, and adjust the threshold control to remove just the largest
clicks.  When done, make the destination the source, and re-run the filter with
the Threshold set back to 1, and adjust the tracking control to get the smaller
clicks.
Another thing to try is to use the file reverse feature, and then process the vinyl
recording through the impulse noise filter.  When done, re-reverse the file.

Q I have a record with one major scratch on it running from the center to the

outside is a spiral pattern.  How do I eliminate the loud „click“ which I hear
which occurs once per revolution of the record?

A You should use the impulse noise filter in the following way.  Set the

tracking control to its minimum value.  Set the threshold to its maximum value.
Set the „samples“ to about five.  While in Preview mode, slowly decrease the
Threshold control until you see the click counter increment once for each click,
which is occurring.  Do not increase the Threshold control any further than
necessary.  Next, increase the „Samples“ control until the click is not longer
audible.  This technique is also useful for getting rid of the clicks produced by
cracked 78-RPM shellac records.  It is even possible to take a broken 78, glue it
together, and then after transferring it, remove the clicks, which occur at the
breakage points.  
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Q How do I generate a simulated stereo wavefile from a monophonic

wavefile?

A Start with a monophonic file that has been de-noised, and convert it to

stereo using the File Conversion Filters.  Some stereo effect may be added here
by applying a littl e „Time Offset“ during this process.  Next, make the
destination the source, to get a new source file.  Run the Reverb effect with a
Small or Medium hall , setting the decay to a low number and the early
reflections level nearly to zero.

Q Does the order in which I process noise out of a wavefile matter?

A Yes.  Always remove clicks and pops with the impulse noise filter before

de-hissing a recording using either the continuous noise filter or the dynamic
noise filter.  And never reduce the bandwidth of an audio signal before applying
the impulse noise filter (and this applies both in the analog side of your signal
path as well as the digital side.)

Q My system is stuttering in preview mode.  What can I do?

A If you have a Pentium 166 MHz or faster computer, almost all of the

software’s filters should run in real time.  (The stereo continuous noise filter is
the slowest determinate algorithm, and the impulse filter can stutter if set to
aggressively on any machine.)  If you are still getting stuttering, try setting the
number of Preview Buffers higher.  The Preview Buffers setting is located in the
Edit->Preferences menu.  Also, make sure that you are not running any other
programs at the same time that you are running Diamond Cut
Mill ennium/LIVE .  Other programs can use CPU cycles, even if they are
seemingly idle.
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Q I have an analog tape recording with clipping distortion due to over-

modulation during the recording process.  Is it possible to „soften“ the clipping
sound in order to reduce the harshness produced during the overloads?

A Clipping distortion can sometimes be reduced by utili zing the Impulse

noise filter.  If the clipping distortion is at the peaks of the waveform, set the
tracking control set to its minimum value, and the threshold set to maximum.
Highlight a segment of the recording which contains distorted and non-distorted
material.  In preview mode and with accuracy optimization checked, adjust the
Threshold control until the clipping distortion is reduced.  In some cases, it may
become necessary to run the Reverse NAB curve before following the above
procedure.  After the distortion has been reduced with the impulse filter, it will
be necessary to run the NAB curve to re-correct the recordings equalization.
These two curves can be found in the factory preset listing under the Paragraphic
Equalizer filter.  The reason for the above two steps is that the saturation
overload occurs at the tape to tape head interface.  The resultant overload is then
phase shifted during playback by the NAB equalization circuit in the tape
recorder.  Utili zing the Reverse NAB curve places the clipping distortion closer
to the peak of the waveform, where is actually occurred.
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Troubleshooting
Listed below are some common causes of problems using Diamond Cut
Millennium/LIVE :
• Exit other programs, especially during recording. While Diamond Cut does

not put any restrictions on the types of programs that may be run while
Diamond Cut Mill ennium/LIVE is running, closing other programs will
increase the chances of a glitchless recording.

• Do not use a compressed drive to record digital audio. If you are using a
compression utilit y such as DriveSpace, DoubleSpace, or Stacker, do not
use the compressed drive for audio recording. The overhead of compression
will slow down the recording process and cause dropouts in the recording.

• Disable any screen saver or background process during recording. When a
screen saver becomes active, it can cause a momentary flurry of disk activity
that may cause dropouts in the audio recording.  Some programs install a
background task in the „Startup“ group of Windows when they are installed.
Make sure any program that is run, will not suddenly cause disk activity.
(One such example is Microsoft’s Fast Find application installed with their
Office Suite products)

• Make sure your computer will not enter an energy saving mode while
recording. Windows 95/98/ME has a feature that allows the hard drives to
be powered off after a certain period. Use the control panel’ „Power“
application to check the timeout period.

• Ensure that you have a Windows 95/98/ME version of your sound card
driver. Many systems that have been upgraded from Windows 3.1 to
Windows 95 are still using the Windows 3.1 sound card drivers. Check the
version of your sound card driver or ask the manufacturer to verify that the
driver was written for Windows 95/98/ME.

• Update your sound and video drivers. You should be using the latest drivers
that are available for your sound and video cards. Many problems can be
resolved by updating the drivers. Drivers are usually available from the
manufacturer via a Bulletin Board Service (BBS), CompuServe, America
On-Line, or the World Wide Web.  Contact the manufacturer for details.
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Purchasing the full version:

Digital Broadcast Systems GmbH
Feldbergstr. 19

D-61440 Oberursel
Germany

Phone 0049-6171-582010
Fax 0049-6171-582012

Email: info@diamondcut.de
Webadresse: www.diamondcut.de

Technical support for registered users:
Email: support@diamondcut.de
Web Page: www.diamondcut.de

Phone 0049-6171-582010
Fax      0049-6171-582012
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Enjoyment!

Some people will buy this program just for the heck of it and then wonder what
to do with it.  Have some fun!  It can be really rewarding to take a junky olde
recording that has been long forgotten and try to turn it into a "Lerner and Lowe
Musical."  If you can take an old amateur recording, and make it seem almost
professional in terms of the recording quality, it will get the attention of the folks
who were involved with the original production many years prior.  Send
everyone free copies of your "restoration" and watch the reaction!  Most people
will be thrill ed to hear their past presented in such realistic (although sometimes
embarrassing) detail.

Or - - -

Have you ever noticed that you can always tell which records you loved to listen
to 20 or 30 years ago just by looking at them?  The ones which are in perfect
shape today are the ones you hated, and the ones which make you cringe to listen
to today (because of all of the noise and distortion on them) are the ones you
loved back then (sort of ironic, right).  Record collectors will find Diamond Cut
Mill ennium/LIVE to be a valuable tool for the restoration of some of those old
recordings that have not been re-released on CD yet.  Some of the fun is in the
process of restoration itself.  It is very rewarding to be able to dust away the
cobwebs which time has entangled on your rare record recordings.  They often
can be made to sound almost as good as new.   And if you purchase a CD-ROM
writer (which is compatible with the .WAV file format), then you can enjoy
them as you did years ago, but without the fear of wearing them out.
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System Requirements

1. 166 MHz Pentium or better.
2. 16 bit Stereophonic Sound Card with line level inputs, or a "Digital Only"

Card.
3. 16 Mbytes of RAM*.
4. Windows 95/98/ME, Windows NT 4.0/2000 or higher.
5. An Audio Source.
6. An Audio Reproduction System.
7. A Hard Drive with enough space to accommodate your Wavefiles.  A

formula is provided to calculate the space requirement under Recording
Audio Signals onto your Hard Drive. (The program requires 2 Mbytes by
itself).

8. Mouse, Keyboard, and Color Monitor.

*  If your computer has 16 Mbytes of RAM, further increases in the quantity of
RAM will not appreciably speed up the Diamond Cut Mill ennium/LIVE
algorithms.


